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Using Formulas 
 
Formulas are used to perform calculations on values entered into the cells of a 
worksheet. They consist of the addresses of the cells containing the values and the 
appropriate mathematical operators. Formulas begin with an equal sign (=) because 
they contain cell addresses. This prevents Excel from interpreting the formula as text, 
since cell addresses begin with letters. For example, to add the numbers in cells A1 and 
A2, you would type the formula =A1+A2. 
 
You enter the formula in the cell where you want the result to appear. Because formulas 
use cell addresses, they automatically recalculate when the value of a cell used in a 
formula changes. When a cell containing a formula is selected, the actual formula 
appears in the formula bar. The calculated results of the formula appear in the cell. 
 
1. Select the cell into which you want to enter the formula. 

2.   Begin the formula with an equal sign (=). 

3. Enter the rest of the formula. 

4. Press [Enter]. 

 

Using Functions 
 
Some formulas are used so commonly that Excel has created special functions that 
produce the results of those formulas. Some example functions are included in the 
following table: 
 

Function Syntax Description 

SUM =SUM(A1:A20) Provides the sum of all the 
numbers in a range. 

AVERAGE =AVERAGE(A1:A20) Returns the average of a range 
of numbers. If a cell in the 
range is empty, it is not 
included in calculating the 
average. If a cell in the range 
contains the number zero, it is 
included in calculating the 
average. 

MAX =MAX(A1:A20) Returns the highest value in a 
range of numbers. 
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Function Syntax Description 

MIN =MIN(A1:A20) Returns the lowest value in a 
range of numbers. 

COUNT =COUNT(A1:A20) Returns the number of cells 
that contain numbers. 

 
Another Function: Autosum 
 
Since the SUM function is used frequently, there is an AutoSum button on the 
toolbar that writes the formula in the active cell for you. The AutoSum button is an 
easy way to sum values in a row or column of a worksheet. 

 
1. Select the cell into which you want to enter the formula. 

2. Click the AutoSum button . 

3. Press [Enter]. 
 

Formatting Cells 
 
1. Change cell appearance You can change the appearance of the contents of cells by 
changing the alignment, borders, color, font, format, etc. Some of the more unusual 
formatting procedures are discussed below. 
2. Use the Merge and Center button You can select several cells, merge them into 
one cell, and center the entry in that cell over the columns in a worksheet. This option is 
useful when you want to center a title above specified columns in a worksheet. 
 

1. 1. 1.  Select the cells you want to merge and center. 

2. 2. 2.  Release the mouse button. 

3. 3. 3.  Click the Merge and Center button . 

 
3. Use the Borders button Cell borders are lines you can place on the edges of the 
cells in a worksheet. For example, you may want the column headings, row titles, and 
row totals of a worksheet to appear with wider lines to emphasize these cells. Excel 
contains twelve border styles that place lines of varying widths at different edges of the 
cells. In addition, you can add cell borders to an entire range of cells. Borders are 
attached to the cells and appear regardless of the cell entry. 
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The Borders button has two parts. You can use the list to display a list of border styles 
and choose a desired border style. The display on the button changes to display the 
currently selected border. To apply the currently selected border to other cells, you can 
click the button. 
 
1. Select the range to which you want to add a border. 

2. Click the arrow on the Borders button  on the Formatting 
toolbar. 

3. Select the desired border style. 

 
4. Use the Fill Color button You can add shading to the background of cells using the 
Fill Color button. For example, you can use shading to make the column headings 
distinct from the rest of the worksheet. Although color displays on the screen, it will not 
print unless you have a color printer. Colors will print as shades of gray on a black and 
white printer. 
 
The Fill Color button has two parts. You can use the list to display the color palette and 
choose the desired color. The display on the button changes to display the currently 
selected color. To apply the currently selected color to other cells, you can click the 
button. 
 
1. Select the range to which you want to add a color. 

2. Click the arrow on the Fill Color button  on the Formatting 
toolbar. 

3. Select the desired color. 

 
5. Use the Format Painter button The Format Painter button copies formats from a 
cell or range to another cell or range. This button prevents you from having to 
individually apply the formats to each cell or range every time you want to format cells. 
For example, if you apply bolding, italics, underlining, and shading to a cell, you can 
apply all of these formats, at one time, using the Format Painter button. 
 
1. Select the cell containing the format you want to copy. 

2. Click the Format Painter button . 
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3. Select the range to which you want to apply the format. 

 
You can use the Format Painter button to copy cell formatting to several non-adjacent 
cells or ranges at once. You do not have to reselect the Format Painter button each time 
you want to format a non-adjacent cell or range. For example, you may want to copy all 
the formats from range A1:A5 to both A10:A15 and A20:A25. 
 
1. Select the cell containing the format you want to copy. 

2. Double-click the Format Painter button . 

3. Select the cells to which you want to apply the format. 

4. Select any additional cells to which you want to apply the 
format. 

5. Click the Format Painter button  to deselect it. 

 
6. Clear formats You can clear all the formats in a cell or range all at once. Clearing 
formats removes all formatting attached to the cell or range, including number formats, 
font formats, cell borders, and shading. If you only want to clear a single format, such as 
bolding, you should remove that format individually. 
 
1. Select the cells containing the formats you want to clear. 

2. Select the Edit menu. 

3. Point to the Clear command. 

4. Select the Formats command. 

 
7. Use conditional formatting You can use the Conditional Formatting feature to 
emphasize data that meets certain conditions in cells or formulas. For example, you can 
set up the Conditional Formatting feature so that all sales that are greater than or equal 
to a certain value will appear in a different color. You can change the formatting option 
that is used to emphasize data which meets a condition. 
 
The Conditional Formatting feature has two options, the Cell Value Is and Formula Is. 
The Cell Value Is option allows you to compare the values of selected cells to 
conditions, such as greater than or less than. The Formula Is option allows you to 
compare the results of a logical formula to a selected range of cells, where the formula 
produces either a true or false result indicated by the selected formatting. 
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1. Select the range to which you want to apply conditional 

formatting. 

2. Select the Format menu. 

3. Select the Conditional Formatting command. 

4. Select the first list under Condition 1 to choose the criteria on 
which you want to apply the conditional formatting. 

5. Select the desired option. 

6. Select the second list under Condition 1 to choose the desired 
condition. 

7. Select the desired condition. 

8. Select the text box under Condition 1. 

9. Type the value to be used as the formatting criteria. 

10. Select Format. 

11. Select the Color list. 

12. Select the color you want to apply to the values that meet the 
specified condition. 

13. Select OK. 

14. Select OK. 
 
You can change a conditional format. For example, you may have a worksheet that 
displays cells with values less than $4000 in red. You can change the condition to 
recognize a different value. 
 
1. Select the range containing the conditional format you want to 

change. 

2. Select the Format menu. 

3. Select the Conditional Formatting command. 

4. Select the second list under Condition 1 to choose the desired 
condition. 

5. Select the desired condition. 

6. Select the text box under Condition 1. 

7. Type the value to be used as the new formatting criteria. 
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8. Select OK. 
 
You can delete one or more conditions from a conditionally formatted range. For 
example, you may have a worksheet that displays cells with values less than $4000 in 
red and cells with values greater than $8000 in blue. You may want to delete the 
condition which displays values in blue so that only one condition is emphasized. 
 
1. Select the range containing the conditional format you want to 

delete. 

2. Select the Format menu. 

3. Select the Conditional Formatting command. 

4. Select Delete. 

5. Select the check box of the condition you want to delete. 

6. Select OK. 

7. Select OK. 
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Manipulating Columns and Rows 
 
Select columns and rows  You can select a column by clicking on the header row.  

1. Change the width of columns To adjust column width, place cursor in between 
column headers (A, B) until you get a sideways arrow.  Click and drag to adjust width. 

2. Change the height of rows To adjust row height, place cursor in between row 
headers (2,3) until you get a vertical arrow.  Click and drag to adjust height. 
 
3. Hiding / Unhiding Rows You can hide columns or rows to conceal the entries in 
them. For example, you may want to hide columns or rows that contain salary data. 
Hidden columns and rows do not appear in the worksheet and do not print. Any number 
in a hidden column or row is still calculated while the column or row is hidden. 
 
1. Select the column(s) or row(s) you want to hide. 

2. Click the right mouse button on one of the selected column(s) or 
row(s). 

3. Select the Hide command. 
 
You can redisplay hidden columns and rows. For example, after making a 
presentation in which confidential information was hidden, you can unhide the columns 
or rows to continue your normal worksheet process. Unhidden columns and rows are 
reset to the column width or row height prior to being hidden. 
 
1. Select the column(s) or row(s) on either side of the hidden 

columns or rows. 

2. Click the right mouse button on one of the selected column(s) or 
row(s). 

3. Select the Unhide command. 
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Using Large Worksheets 
 
1. Split the window You can split the workbook window into two or four panes. 
With two panes, you can have either horizontal or vertical panes. With four 
panes, the display is divided into four sections. 
 
To split the window, you use the horizontal and vertical split boxes. The 
horizontal split box is located at the top of the vertical scroll bar. The vertical split 
box is located at the right end of the horizontal scroll bar. When you drag the split 
boxes, a line appears in the worksheet indicating where the split is located. You 
can drag the line to readjust the size of the panes. 
 
1. To split the workbook window into horizontal panes, 

position the cell pointer in the row below the desired split. 

2. Double-click the split box. 

3. To view different areas of the worksheet in the horizontal 
panes, click either vertical scroll bar. 

4. To split the workbook window into vertical panes, position 
the cell pointer in the column to the right of the desired 
split. 

5. Double-click the vertical split box. 

6. To view different areas of the worksheet in the vertical 
panes, click either horizontal scroll bar. 

 
2. Remove panes You can remove the panes from a workbook window by 
double-clicking the horizontal or vertical split bar. You can remove the panes 
when you no longer need to view distant areas of the worksheet. For example, 
after you have viewed the regional totals in a large sales worksheet, you may 
want to view only the figures for one region. 
 
1. To remove horizontal panes, double-click the horizontal 

split bar. 

2. To remove vertical panes, double-click the vertical split 
bar. 

 
3. Freeze panes Occasionally a worksheet is so large you cannot view the 
column or row headings and all the data at the same time. When this happens, it 
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is difficult to view the headings for the data in the worksheet. For example, in a 
worksheet containing sales figures for several hundred sales representatives, 
you cannot view the column headings and the representatives at the bottom of 
the list at the same time. To solve this problem, you can freeze worksheet titles in 
panes. Freezing panes prevents the row and column headings from scrolling out 
of view as you navigate the worksheet. Frozen panes are indicated by a line 
below a row and a line to the right of a column. 
 
1. To freeze both row and column headings, place the cell 

pointer in the cell directly below the column headings you 
want to freeze and to the right of the row headings you 
want to freeze. 

2. Select the Window menu. 

3. Select the Freeze Panes command. 

 
4. Unfreeze panes After you have frozen headings in a large worksheet, you can 
unfreeze the panes. Unfreezing removes the panes so that title rows or columns 
are no longer frozen on the screen. 
 
1. Select the Window menu. 

2. Select the Unfreeze Panes command. 

 

Working with Multiple Worksheets 
 
Workbook files can contain multiple worksheets. Using multiple worksheets is a 
convenient way to manage related data in the same workbook. For example, you 
can enter sales data for individual months, quarters, or regions in separate 
worksheets. You also can create summary worksheets that add numbers from 
each of the worksheets in a workbook. In addition, you can group worksheets to 
apply consistent formatting, as well as to print all the worksheets as a group. 
 
By default, a new workbook contains three worksheets. The name of each 
worksheet appears on a tab above the status bar. The default name is Sheet 
followed by a number. You can change the name to indicate the type of 
information on the worksheet (Expenses, for example). A workbook can contain 
up to 255 worksheets. Worksheets can be moved and copied within the current 
workbook. 
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1. Navigate between worksheets You can display a worksheet by clicking its 
tab. However, by default, only six worksheet tabs appear in the workbook 
window. If you have more than six worksheets, you cannot see all the worksheet 
tabs at one time. For example, in a workbook that contains worksheets for every 
month of the year, the tabs for the last few months of the year would be hidden, 
depending on how the months are named. If the worksheet tab you want to view 
is not visible, you can use the tab scrolling buttons to display hidden tabs.  
 

Button Function 

 Displays the next worksheet tab to the right. 

 Displays the previous worksheet tab to the left. 

 Displays the last worksheet tab in the workbook. 

 Displays the first worksheet tab in the workbook. 

 
2. Rename worksheets You can replace the default worksheet names with 
descriptive names. For example, a worksheet containing January sales figures 
can be named January. Worksheet names can be up to 31 characters long, but 
cannot include colons (:), slash marks (/), backslashes (\), question marks (?), or 
asterisks (*). In addition, the name cannot be enclosed in square brackets ([]). 
Each worksheet name in a workbook must be unique. 
 
1. Double-click the worksheet tab you want to rename. 

2. Type the desired worksheet name. 

3. Press [Enter]. 
 
3. Insert worksheets You can insert new worksheets into a workbook. For 
example, in a workbook containing worksheets for each month of the year, you 
can add worksheets for each quarter of the year. New worksheets are inserted to 
the left of the current worksheet. Excel gives new worksheets a default worksheet 
name, which you can change, if desired. 
 
1. Select the worksheet to the right of which you want to 

insert a new worksheet. 

2. Select the Insert menu. 

3. Select the Worksheet command. 



 12 

Copying and moving data between worksheets is as simple as selecting 
and copying cells, selecting the desired worksheet, selecting the desired 
location in the worksheet, and pasting the cells. 
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Creating Charts 
 
A chart uses values in a worksheet to create a graphic representation of their 
relationship to one another. You can use charts to make it easier to spot trends, 
highlight important changes, and compare individual figures. For example, when 
comparing sales amounts, a column chart dramatically illustrates differences 
between two or more sales amounts. Using charts in reports and presentations 
displays numbers to your audience in a format that is easy to understand. 
 
When you create a chart, each row or column of data on the worksheet makes up 
a data series. Each individual value within the row or column is called a data 
point. 
 
The range you chart can include row and column headings. These headings are 
used as the category labels and the legend text. If the range does not include 
headings, Excel creates default headings. 
 
In Excel, you either embed a chart in the worksheet, or you create it on a chart 
sheet. An embedded chart is a chart object in the worksheet. When you want the 
chart and the worksheet data viewed or printed together, you should use an 
embedded chart. 
 
A chart sheet is a separate worksheet in the workbook that contains only the 
chart. If you want to use the chart by itself (for example, in a presentation) you 
should use a chart sheet. Both kinds of charts are linked to the worksheet data 
and update automatically if the data is changed. 
 
1. Create charts - Chart Wizard The Chart Wizard assists you in creating a 
chart by leading you through a series of dialog boxes that allow you to choose 
options for the chart. The Chart Wizard contains four steps. In the first step, you 
select the chart type and sub-type. In the second step, you select or verify the 
data that will be used to create the chart. The third step allows you to select 
various chart options. The last step determines whether the chart will be 
embedded in the worksheet or displayed in its own chart sheet. 
2. Move and resize charts A chart can be moved to a desired location on a 
worksheet by dragging it to the new location. It can be resized using the resizing 
tabs at the corners and midpoints of the chart edges. 
Identify chart objects The various chart objects and their descriptions are listed in 
the following table: 
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Object Description 

Chart area The entire area inside the chart border including the 
chart itself and all related elements. 

Plot area The area in which Excel plots data. 

Category 
axis (x axis)  

The axis that contains the categories being plotted. It 
is usually the horizontal axis. 

Value axis    
(y axis)  

The axis that contains the values being plotted. It is 
usually the vertical axis. 

Chart title Text describing the chart that is automatically 
centered and placed at the top of the chart. 

Legend Describes the data series being plotted. 

Series 
markers 

Graphic elements that make up your data plot, such 
as bars or lines. The chart tip names the series using 
the name displayed in the legend. 

Data points The individual parts of a data series. Data points can 
be bars, points on a line, a slice of a pie, a circle, etc. 
Data points are identified in chart tips using the series 
name and the value of the data point. 

Gridlines Lines that extend from an axis across the plot area to 
help guide the eye from the data point to its 
corresponding value. 

 
3. The chart toolbar The tools available on the Chart toolbar along with their 
functions are listed in the following table: 
 

Tools Use 

 Chart Type 
Changes the chart type. 

 Legend 
Shows or hides the legend. 

 Format 
Provides formatting options for the 
selected chart object. 

 Data Table 
Adds or removes the data table that 
displays the data used to create the 
chart. 
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Tools Use 

 By Row 
Changes the plot direction so that the 
data is plotted by row. 

 By Column 
Changes the plot direction so that the 
data is plotted by column. 

 Angle Text 
Downward 

Angles the text in the selected object 
downward. 

 Angle Text Upward 
Angles the text in the selected object 
upward. 

 
Chart Objects 

Provides a list of chart objects. 

 
4. Print a chart Charts embedded on a worksheet print automatically when you 
print the worksheet. If you want to print the chart alone, select the chart before 
you print. For example, you can print the chart alone if you want to use the chart 
to create a slide overhead for a presentation. 
 
1. To print the chart without the worksheet, select the chart. 

2. Click the Print button . 

3. To print the chart with the worksheet, click outside the 
chart in the worksheet area. 

4. Click the Print button . 
 


